Instructor User Guide (updated 9.26.06)
Contents

1 Getting Started 6

Creating Your User Profile 6
Logging In 6
Joining an Account 7
Creating a Class 7
Creating an Assignment 8
Getting Your Students Started 10
Submitting Papers 13
Assignment Inbox 15
Managing Students 17
Originality Reports 18

3 Peer Review 23

Overview 23
Creating a Peer Review 23
Viewing Paper Distributions 27
Writing a Review 28
Reading Reviews 30
Creating a Writing Review 30

4 GradeMark™ 33

Grading Marks 33
Comments 34
Inline Comments 36
QuickMarks 36
Rubrics 38
5 GradeBook

Point Values 44
Adding Entries 44
GradeBook Preferences 45
Entering Grades 45
GradeBook Student Page 46
Scaling and Dropping Grades 47
Graphing Tools 48
Attendance 49
Exporting GradeBook 49
GradeBook Key 49

6 Digital Portfolio

Creating a Portfolio Assignment 50
Submitting Files 51
Portfolio Inbox 51

7 Class Calendar

Opening the Calendar 52
Assignment Dates 52
Calendar Entries 52
Uploading a Syllabus 54
Calendar List 55

8 Discussion Boards

Posting a Discussion Topic 56
Contents

Posting a Reply 57
Discussion Views 58
Moderation 60
Letting Students Post Topics 61

9 Libraries 62
Assignment Library 62
Rubric Library 63
Peer Review Library 64
Topic Question Library 64
Metric Library 65

10 Class Sections 67
Creating a Master Class 67
Adding Sections 67
Administering a Master Class 68
Creating Assignments 69
Student Enrollment 70
GradeBook 71
Calendar 71

11 Quick Submit 73
Accessing Quick Submit 73
Submitting Papers 73

12 Preferences & Notifications 75
User Preferences 75
Class Preferences 76
Messages and Announcements 76
1 Getting Started

Welcome to Turnitin! This user guide will provide you with a thorough introduction to our plagiarism prevention system and class management tools. Turnitin is available online at www.turnitin.com.

Creating Your User Profile

All Turnitin users must create a user profile. If you have previously used Turnitin, are an account administrator, or if your administrator has already added you to an account, you will already have a user profile and can skip ahead to the next section Logging In.

If you are new to Turnitin and your administrator has not yet added you to an account, you need to create a profile.

To create a user profile:

2. Click New Users on the Turnitin homepage.
3. Follow the on-screen instructions. When you are done creating your profile, you will be asked if you would like to use the instructor startup wizard. We recommend that all new users use the wizard to setup their first class. At the end of the profile creation process, you will be logged in to Turnitin.

If you used the instructor startup wizard, you can bypass the next few steps proceed to Getting Your Students Started in this chapter. If you do not use the startup wizard, skip ahead to Creating a Class.

Logging In

To login:

2. At the top right, enter your e-mail address and user password.
3. Click Login to open your Turnitin homepage.
Joining an Account

Your instructor homepage lists your account and any classes you have created. If an account is not listed on your homepage, you will need to join an account before you can start using Turnitin.

To join an account:

1. Click the *join account* tab at the top left of your Turnitin homepage.
2. On the next screen, enter the account ID and join password for your account.
3. Click the *submit* button to add the account to your homepage.

If you do not have an account ID and join password, please contact your institution’s account administrator.

Creating a Class

Most of your activity at Turnitin will take place within a class or classes that you create. You can use classes (and assignments within them) to structure and organize your students’ submissions. You may have one or many Turnitin classes depending on how you choose to use the system.

To create a class:

1. Click the *add a class* link on your instructor homepage.
2. On the next screen, enter the following:
   - a class name
   - a class enrollment password (Students will use this password to enroll in your class. Make sure your password is easy for your students to remember, and take note of the password so you can distribute it to your students.)
3. Choose an end date for your class. Once the end date has passed, the class will expire and will not be accessible by you or your students (refer to the next section Expired Classes for more information).
4. If you would like to let students view their own reports, click the checkbox next to the view reports option.
5. Click submit to add the class. You will now see your new class homepage and a pop-up confirmation window, containing the Turnitin class ID for your class.

Make careful note of your class ID. Your students will need this number and your enrollment password to enroll in your class.

Expired Classes

Each class you create has an end date. When a class reaches its end date, it expires and enters a read-only state. You and your students will no longer be able to submit papers and peer reviews to an expired class.

When a class expires, it no longer appears with your active classes. To view expired classes, select expired using the pulldown on your homepage 1. Only those classes that are expired will be shown. If you would like, you can view all classes by selecting all classes with the pulldown.

If a class has expired and you would like to make it an active class, click the class update button 2. From the class update screen, you can change the end date for the class.

Creating an Assignment

All papers are submitted to assignments that you create. Assignments for a given class are created, displayed, and modified from the class homepage. Click on the name of a class to open its homepage 3.

To create an assignment:

1. Click the create a new assignment link 4.

2. On the next page, enter the following:
   - assignment title
   - point value (optional; shown only if GradeBook is active)
   - special assignment instructions (optional)

3. Select a start and due date for the assignment. If you would like, you can also choose specific start and due times for your assignment. Students can begin submitting papers to an assignment once the start date arrives and will be blocked from
submitting papers once the due date has passed.

4. Choose whether you would like to receive Originality Reports for papers submitted to this assignment. The default is yes.

5. Click submit to finalize the assignment. It will appear on your class homepage.

GradeMark and GradeBook users will also have the option to set a post date for the assignment. The post date is the date on which GradeMarks and grades for the assignment become available for students to view.

### Advanced Assignment Options

When you create a paper assignment, you can choose to view advanced assignment options using the pulldown at the bottom of the assignment creation form. With advanced assignment options, you can choose from the following Originality Report options:

1. Generate Originality Report for student submissions:
   - **immediately (first report is final)**
     Reports will be generated immediately for all submissions and students cannot resubmit their papers (default).
   - **immediately (can overwrite reports until due date)**
     Reports for a student's initial submission will be generated immediately. Students can choose to resubmit their papers and receive Originality Reports as many times as they would like up until the assignment's due date. Please note that reports are generated immediately only for a student's first submission; reports for subsequent submissions are delayed 24 hours.
   - **on due date**
     Originality Reports will not be generated for submissions until the assignment's due date. Students can submit their papers as many times as they would like up until the assignment's due date.

2. Choose whether you would like to allow student submissions after the assignment due date.

3. Allow other papers to be checked against submissions? Choose yes if you would like papers sub-
mitted to this assignment indexed in our database. If you do not would like papers submitted to this assignment stored in our database and used for future plagiarism searches, select no.

4. Select the sources you would like papers submitted to this assignment checked against. The three sources you can choose from are:
   - student paper database that includes all papers submitted to Turnitin
   - current and archived internet
   - Gale InfoTrac OneFile

5. If you make changes to the advanced options, a pulldown will appear. To save the options you have selected for assignments you create in the future, select yes using the save options pulldown.

Click submit to create your assignment using the specified advanced assignment options.

Revision Assignments

Students can only submit one paper per assignment. If you would like your students to submit another draft of their papers, you can create a revision assignment. Revision assignments make duplicating an assignment easy.

To create a revision assignment, click the create a new assignment link on your class homepage 1. Using the pulldown at the top of the assignment page, select revision assignment 2. The revision form will open. You will need to select a paper as assignment for the revision assignment. You will also need to enter dates and optional assignment instructions and a point value (appears only for GradeBook users).

Getting Your Students Started

After you have set up your first assignment, you and your students are ready to start submitting papers. If you are going to submit papers yourself, you can skip to the next section, Submitting Papers.

We strongly recommend you have students submit papers themselves. This will save you time and enable you to use other products such as Peer Review, GradeMark, and GradeBook.
Enrolling Your Students

Students must be enrolled in your class to submit papers. Students can enroll themselves by creating a user profile and using your class ID and password information, or you can manually enroll students in your class.

To have your students enroll:

1. Give your students your class ID and class enrollment password. If you have forgotten this information, you can access it at any time by clicking the stats icon next to the name of your class on your Turnitin homepage ①.

2. Instruct your students to create user profiles at Turnitin, just as you did. They will be able to use the student class enrollment wizard to get set up and start submitting papers.

If you prefer to manually enroll students in your class, you can add students individually or all at once.

To enroll students individually:

1. Click the students tab on the class bar to open your students page ②.

2. Click the add student link ③.

3. On the following screen, enter the student’s first name, last name, and e-mail address.

4. Click submit to enroll the student in your class.
   The student will be added to your student list ④.

If you would like, you can enroll all of your students at once by submitting a list of your students in a text, MS Word, or MS Excel file. Each student should be listed in this format (one student per line):

Joe,Brown,jbrown@mydomain.com

Once you have put together a list of students, you can upload it to your class from your students page.

⚠ Your student list will be rejected if it contains 100 or more students.

To enroll students all-at-once:

1. From your students page, click the upload student list link ⑤.
2. On the page that opens, click the **Browse** button and locate your student list file. Click **submit** to upload the list.

3. The information from the file will be shown. If it is correct, click **yes, submit** ①. If it is incorrect, click **no, go back** to select a different file.

4. The final screen displays the newly enrolled students. To return to your student list, click the **finish** link ②. To submit another list, click **resubmit** ③.

   The students will be added to your student list and can log in and start submitting papers.

**Enrollment E-mails and Login Status**

As soon as you add a student to your class a confirmation e-mail is sent to the student. Until the student logs in for the first time, the enrollment date next to the student's name is highlighted in red ④. Once the student logs in, the red highlight will disappear.

If you've entered an incorrect e-mail address for a student or if a student never received his or her enrollment e-mail, you can resend the enrollment e-mail by clicking on the enrollment date highlighted in red ④. On the form that opens, you can resend the enrollment e-mail by clicking the **submit** button. If you entered an incorrect name or e-mail address for the student, you can change this information and click **submit** to send the enrollment e-mail to the new e-mail address ④.
Submitting Papers

For instructors, there are four ways to submit papers to Turnitin:

- **file upload** (used to submit a single paper in file format; we accept submissions in Microsoft Word, WordPerfect, RTF, PDF, PostScript, plain text, and HTML formats)
- **bulk upload** (used to submit multiple papers in file format, just like adding attachments to an e-mail)
- **cut and paste** (used to submit a paper in a file format we do not accept, by cutting and pasting the text into a text box)
- **zip file** (used to submit multiple papers as a single zip file)

To submit a paper to an assignment, click the submit icon next to the desired assignment on your class homepage.

To submit a paper by file upload:

1. Select **file upload** from the submission pulldown menu.
2. Select an enrolled student using the pulldown menu on the submission page. Papers that you submit on behalf of a student will appear in the student’s portfolio, just as if the student submitted the paper to your class.

**or**

If you are submitting a paper for a student not enrolled in your class, enter the student’s first and last name.

**Papers you submit for non-enrolled students cannot be used for Peer Review or GradeMark.**

3. Enter a title for the submission.
4. Click the **Browse** button and locate the paper you would like to submit.
5. Click **submit**. On the following page you will be asked to confirm the text of the submission. If the text checks out, click **yes, submit** to finalize the submission.
To submit by cut and paste:

1. Select *cut and paste* from the submission pulldown menu.

2. Select an enrolled student using the pulldown menu on the submission page. Papers that you submit on behalf of a student will appear in the student’s portfolio, just as if the student submitted the paper to your class.

*or*

If you are submitting a paper for a student not enrolled in your class, enter the student’s first and last name.

3. Enter a title for the submission.

4. Cut and paste the paper into the text box and click *submit*.

To cut and paste text, highlight the text of a paper in a word processing or text editing program and select copy from the edit menu. To transfer the text into your browser, place your mouse cursor in the text box of the submission page and select paste from your browser’s edit menu.

To submit multiple papers using bulk upload:

1. Select *bulk upload* from the submission pulldown menu.

2. Select an enrolled student using the pulldown menu on the submission page. Papers that you submit on behalf of a student will appear in the student’s portfolio, just as if the student submitted the paper to your class.

*or*

If you are submitting a paper for a student not enrolled in your class, enter the student’s first and last name (optional – defaults to “anonymous” if a first or last name is not entered).

3. Click the *Browse* button and locate the first paper you would like to submit 1.

4. Enter a paper title (optional – defaults to the name of the submitted file if nothing is entered)

5. Click the *attach* button to add the paper to your batch 2.

6. Repeat steps 2 through 5 for each paper you would like to submit.

1 *Click Browse to locate a paper on your computer.*

2 *Click attach to add the selected paper to your batch.*
7. When you are done adding papers, click the submit button to upload the batch of papers.

To submit multiple papers as a zip file:

1. Select zip file from the submission pulldown menu.
2. Click Browse and locate the zip file containing the papers you would like to submit.
3. Click submit to view the papers in the zip file. You can choose whether you would like to submit a paper by clicking the checkbox in the include? column 1. For each paper you submit, you can select an enrolled student in your class or you can enter the following information:
   - author’s last name (defaults to anonymous)
   - author’s first name (defaults to anonymous)
   - paper title (defaults to file name)

When you are finished entering information for the papers, click submit to upload the papers to your class.

Papers you submit are accessible from the assignment inbox.

### Assignment Inbox

Each assignment has an inbox containing the papers that have been submitted to the assignment. To open an assignment’s inbox, click on the icon in the inbox column on your class homepage 2.

### Viewing and Downloading Papers

Every paper submitted to your class can be viewed online by clicking on its title in the inbox 3. You can download a paper to your computer in file format by clicking on the file icon 4. To download multiple papers at once, click on the checkboxes next to the papers you would like to download and click the download button 5.
Viewing Originality Reports

Originality Reports document potential plagiarism. Any text from the paper matching text in our database is linked to its original source. To access any paper’s Originality Report, click on the report icon for the desired paper 1.

Organizing Your Inbox

If you are teaching a class with many students, your inbox can sometimes become large and unmanageable. You can organize papers in your inbox in several ways, including:

- **sorting by column header**
  
  Click on the top of the student name, paper title, date submitted, or report columns to sort papers by any of these criteria 2.

- **sorting by folder**
  
  Move selected papers into either the viewed or marked folders by checking them and clicking the move to button 3.

- **viewing by selected originality indices**
  
  Every Originality Report has a color that reflects the amount of matching text we found for that paper. You can view papers with selected originality indices by checking the index colors you wish to view and clicking the arrow icon 4.

- **deleting unwanted papers**
  
  You can delete papers at any time by checking them and clicking the delete button 5.

Viewing Late Submissions

Students enrolled in your class show up in your inbox. If a student has not submitted a paper, --no submission-- will show up in place of a paper title. To quickly view which students have not submitted a paper, sort your inbox by paper title by clicking on the title header 6.

If a paper is submitted late to your class, the submission date will appear in red. If no paper has been submitted by the due date, late will show up in the date column in red 6.
Managing Students

Your students page allows you to access each student’s class portfolio (a collection of papers, Originality Reports, Peer Reviews, and marked up papers for a given class), e-mail your students, and block or delete them from your class. Open your students page by clicking on the students tab of the class bar.

Student page main features include:

- **view student class portfolio**
  Click on any student’s name to visit his or her class portfolio.

- **e-mail a student**
  Click on any student’s e-mail address to open your default e-mail program and send an e-mail.

- **e-mail all students**
  Click on the e-mail all students link to send an e-mail to every student in your class.

- **lock/unlock a student**
  Next to every student’s name is a lock icon that toggles to off (green) and on (red). When a student is locked he or she will no longer be able to access your class.

- **delete a student**
  Click the drop icon to permanently remove a student from your class.

Delete students only if you are absolutely sure they will no longer be a part of your class.
2 Plagiarism Prevention

Papers submitted to Turnitin are compared against billions of internet documents, an archived copy of the internet, our local databases of submitted student papers, and a database of periodicals, journals, & publications. Any matching text we find is detailed in an Originality Report sent to your assignment inbox.

Although Originality Reports can be very effective at helping to identify suspected individual cases of plagiarism, Turnitin plagiarism prevention works even more powerfully when used as a deterrent. Students who know that their work could come under effective scrutiny are much more likely to produce original work.

Originality Reports

Originality Reports provide a summary of the matching text found in a submitted paper. When an Originality Report is available to view, an icon will appear in the report column of your assignment inbox. Originality reports that are not yet finished are represented by a grayed-out icon.

The color of the report icon indicates the overall similarity index of the paper, based on how much matching text we found. The possible similarity indices are:

- **blue** (no matching text)
- **green** (1 word-24% matching text)
- **yellow** (25-49% matching text)
- **orange** (50-74% matching text)
- **red** (75-100% matching text)

These indices do not reflect Turnitin’s assessment of whether a paper has or has not been plagiarized. Originality Reports are simply tools to help you find sources that contain text similar to submitted papers. The decision to deem any work plagiarized must be made carefully, and only after careful examination of both the submitted paper and the suspect sources.
To open an Originality Report, click the icon in the report column. The Originality Report will open in a new window.

The Originality Report has three main sections:

- **paper information**
  The report header shows information about the submitted paper including paper title, author, word count, and the date the report was processed.

- **paper text**
  The left side of the report shows the text of the submitted paper. Matching text is highlighted in red and numbered to correspond with sources to the right.

- **matching sources**
  The right side of the report lists the sources of matching text.

### Direct Source Comparison

Direct Source Comparison lets you quickly compare matching text to its source. To activate Direct Source Comparison, click a block of matching text. The source of matching text will open to the right.

If the source you are viewing contains multiple sources of matching text, you can quickly navigate between sources using the up/down arrows. The text in the paper will automatically line up with the source for easy comparison.

If you would like to view matching text from an internet source in its original web context, you can do so by clicking the show in web page link.

When you are done viewing a source, you can return to the list of matching sources by clicking the close link. Or you can immediately jump to another source by clicking on a new block of matching text.
Originality Report Modes

By default, the Originality Report shows you only the highest percentage matches. In some cases, it is possible that smaller matches are obscured by larger matches and are not shown.

If you would like to see an exhaustive list of sources, you can switch to the show matches one at a time mode 1. In this mode, all sources for a given paper are listed, even those that are obscured by larger percentage matches. To view the matching text for a given source in this mode, click the radio button next to a source 2.

If you would like to view an Originality Report showing only matching text and source links without the source view, select quickview (classic) report using the pulldown 1.

Database Sources

Because of our strict privacy policy, sources in the Turnitin database are handled differently from internet sources. If a source is from our database, student papers will show up next to the source 3.

If the source of matching text is a student paper that belongs to one of your classes, the paper will be displayed with the matching text highlighted.

If the paper is from another instructor’s class, we cannot provide direct access to the paper. To view the paper, you must first request permission from the instructor in possession of the paper by clicking the permission request button 4. We will then auto-generate an e-mail detailing your request. If permission to view the paper is granted, a copy of the paper will be sent back to you via e-mail.

Internet Archive Sources

In addition to searching a copy of the active internet, Turnitin also searches a copy of the archived internet, which includes an extensive number of web pages no longer available on the internet. If a match is found in our internet archive, internet (archive) will appear next to the source 5.
Refreshing Reports

Since the internet is constantly changing, you might would like to generate a new report at a later date to see if there are any new matching source documents. Or perhaps you suspect that a student has shared his or her paper with another student. You might also would like to generate a new report for an earlier submission to see if the paper has been submitted to another class.

With the refresh report feature, you can generate new reports for past submissions at any time. When you refresh a report, your current report is deleted and a new report is generated. To refresh a report, click refresh at the top of the report ①.

Excluding Quoted and Bibliographic Material

Originality Reports document all instances of matching text including quoted and bibliographic material. If quoted or bibliographic material is flagged, you can exclude it from the report. To exclude quoted material, click the exclude quoted link ②. To exclude bibliographic material, click the exclude bibliography link ③.

When you exclude material, the Originality Score on the report and in your inbox is updated to reflect the exclusion of matching text.

Please note that the functions for excluding material are approximate. If more material is excluded than you would like, you can re-include excluded material by clicking the include quoted or included bibliography links ④.

Printing and Saving Reports

To print a report in a printer friendly format, click print at the top of the Originality Report ⑤. The report that is printed will be based on the mode you are currently viewing. For example, if you are viewing the report using the default highest matches mode, the report that will be printed will only show the highest matches (see the Originality Report modes section on the previous page for more information).
If you would like to save and download a copy of a report in HTML format, click **save**.

### Report Preferences

From the report preferences pane, you can change the appearance and behavior of Originality Reports. To open the preferences pane, click **prefs** at the top of the report.

From the preference pane, you can change the following report settings:

- **color-code matches**
  
  By default, matching text is color-coded. If you would like to turn off color-coding, select **no** using the pulldown.

- **default mode**
  
  When you open a report, it shows the highest matches together by default. If you would like to change the default mode for the report, select either **show matches one at a time** or **quickview (classic) report**.

- **auto-navigation**
  
  When you navigate to a match, the text scrolls smoothly. If you would like to jump immediately to the next match without scrolling, select **jump to next match**.

When you are done making changes to the report preferences, click **save and close**.

### Excluding a Source

If you would like to exclude a source from the **show highest matches together** or **quickview** mode of your Originality Report, you can do so by clicking the gray "x" to the right of the source.

Excluded sources will still appear in the Single Source Mode of the Originality Report. You can restore excluded sources by clicking the gray "+" to the right of the source.
Peer Review

Peer Review lets your students anonymously read and review the papers of their peers. At the end of a peer review, your students will have received helpful feedback that can help improve the quality of their writing.

Overview

Here’s a brief overview of how the peer review process works:

- You choose an assignment to use for Peer Review. Any papers submitted to that assignment will be included in the review.
- You create topic and metric questions that your students will use to evaluate each other’s papers.
- You determine how many papers each student will review and how they will be distributed to your students.

After papers are distributed, students receive their assigned papers in their class portfolio and can begin writing reviews. Once the review session ends, students can read the reviews written for their work, in addition to reviews posted for other papers in the class.

Creating a Peer Review

To distribute an assignment as a peer review, click the create a new assignment link on your class homepage. Select peer review assignment as our assignment type.

Step 1 – Select Assignment and Review Dates

To create a peer review, select a paper assignment to use for the review. The papers that have been submitted to the selected assignment will be distributed to your students.

Next select dates for your peer review. The dates that you will need to select are:
• a **start date**. This is the date students can begin reading papers and writing reviews.

• a **due date**. Students will not be able to write reviews after this date.

• a **post date**. This is the date students will have access to reviews written by their classmates.

Additional assignment criteria include:

• anonymous (default); click the checkbox to make the review non-anonymous.

• title (optional)

• point value (applies to GradeBook users only)

• additional assignment instructions (optional)

• peer review source

If you would like to select a peer review that you have previously created from your library, use the pulldown to select *use peer review library*. Your peer review library will open so that you can select a review (*refer to Chapter 9 for more information on the peer review library*). If you are creating a new peer review assignment, make sure the peer review source is set to *create your own review*.

When you are done, click **submit** to proceed to step 2.

**Step 2 – Adding Topic Questions**

In Step 2 you choose topic questions for the review. For example, a topic question might be:

“*Identify the thesis of this paper and discuss its overall effectiveness.*”

To add a topic question to your review:

1. Enter a topic question in the text box.

2. Select an optional minimum response length for the question.

3. Select a category for the topic question.

   ![Image](image.png) The category is used to organize your questions in your question library (for more information on the question library, please refer to Chapter 9).

4. Click **add** to add the topic question to your assignment. When topic questions are added,
they stack at the bottom of your browser window in the topic question table.

Repeat steps 1 through 4 for each of your topic questions. Once topic questions have been added to your review, you can revise or delete them if necessary. To revise a topic question, click the question’s revise icon ①. Click the delete icon to remove the topic question from the review ②.

If you would like to use a topic question that you have previously created or select a question from the Turnitin topic library, click the topic library link to open the library of topic questions ③ (refer to Chapter 9 for more information on the topic library).

When you are finished adding topic questions to your review, click submit to proceed to step 3.

**Step 3 – Adding Metric Questions**

In step 3, you choose metric questions for your review. For example, a metric question might be:

“*On a scale of 1 to 5, rate the effectiveness of the author’s thesis.*”

Metric questions are always in this form and are rated on a scale of 1 to 5.

To add a metric question to your review:

1. Enter a metric question in the text box.
2. Select a category for your metric questions.
   
   **The category is used to organize your questions in your question library (for more information on the question library, please refer to Chapter 9).**

3. Click add to add the metric question to your assignment ④. When metric questions are added, they stack at the bottom of your browser window in the metric table.

Repeat steps 1 through 3 for each metric question you would like to add to the review. Once metric questions have been added to your review, you can revise or delete them if necessary. To revise a metric question, click the metric’s revise icon ⑤. Click the delete icon to remove the metric question from the review ⑥.
If you would like to use a metric question that you have previously created or select a metric question from the Turnitin metric library, click the metric library link to open the library of metric questions (refer to Chapter 9 for more information on the metric library).

When you are finished adding metric questions to your review, click submit to proceed to step 4.

**Step 4 – Distributing Papers (if all papers have been submitted to the assignment)**

In Step 4 you determine how papers will be distributed to your students. All eligible students are listed in a table to the left, and all available papers are listed in the table to the right.

To distribute papers (if all papers have been submitted):

1. Select the number of papers you would like to randomly assign to each student for review.
2. Select the number of papers each student will choose to review.
   
   The number of papers you assign to each student and the number you allow each student to choose for review will equal the number of papers each student must review. For example, if you assign two papers randomly to each student and let each student review two papers of his or her choosing, each student in the class will need to write four reviews.

3. If there are students or papers you would like to lock out from the review, you can do so by clicking on the lock icon next to the student or paper. Each time you click a lock icon, it will toggle between green (active) and red (locked). Locked papers will not be distributed to students and locked students will not receive papers to review.

4. Click the distribute button to send papers to your students using the criteria you have selected.

Papers distributed to your students will appear in the papers assigned column. The numbers that appear correspond with the papers listed in the papers available column to the right. Question marks represent a paper that students can choose for review.

Click submit to add the review. The review will stack beneath its assignment on your class homepage.
Step 4 – Distributing Papers (if some papers or no papers have been submitted to the assignment)

If your students have not yet submitted all of their papers to the assignment being used for the review, you can still determine how papers will be distributed ahead of time. Papers will be distributed to your specifications on the review’s start date.

Because papers will be distributed on the peer review start date, this date should come after the original assignment’s due date. This will ensure that your students have had the opportunity to submit their papers before they are distributed.

To set a distribution for a peer review:

1. Select the number of papers you would like randomly distributed to each student.
2. Select the number of papers you would like each student to choose for review.
3. Click submit to confirm the distribution and finalize the peer review.

Once you have completed creating a peer review, the review will stack beneath its assignment on your class homepage.

Viewing Paper Distributions

To view the current distribution of papers for a review, click the review’s distribution icon from your class homepage. The paper distribution screen will appear showing the current distribution of papers.

Redistributing Papers

You can redistribute papers for a peer review until a student submits a review. After a student submits a review (or after the peer review due date), you will not be able to distribute papers for the class. You can, however, still distribute papers manually to those students who have not yet written reviews.

To manually assign a paper or papers:

1. Click the checkbox next to the paper(s) you would like to assign to a student.
2. Click the update icon next to the student who will review the selected papers.

The paper(s) will appear next to the student in the papers assigned column.

⚠️ Keep in mind that when you manually assign papers (or completely redistribute papers to your class), you still need to click submit to finalize your review.

## Writing a Review

If you would like, you can also write a review to supplement those that your students will receive from their peers.

To write a review, click the peer review tab at the top of your class homepage, or click the pencil icon next to a review to open the peer review page to the selected review.

At the top of the peer review page is a pulldown menu containing your class’s reviews. Use the pulldown to view a review assignment.

To review a paper:

- Click the peer review (pencil) icon next to the paper you would like to review.

The peer review form will open. The top frame of the peer review form contains paper information, a navigational bar to toggle the topic and metric questions you are currently viewing, and a form for entering your responses. The bottom frame contains the text of the paper you are viewing.

To respond to a topic question:

1. Enter your response in the text box. If there is a minimum response length, it will appear in red next to the question.
2. Click submit to enter your response and proceed to the next topic question.

To respond to metric questions:

1. Click the view metrics link to display the review’s metrics. You will automatically be taken to the metrics once you have finished the topic questions.
2. Click a radio button in the 1, 2, 3, 4, or 5 column to rate a metric question.

3. When you have rated all of the metric questions, click submit to confirm your entries.

Adding Marks

If a paper has been submitted in Word or plain text format, you can add marks to the paper during the review process. You can then reference your marks within your topic responses. You can also associate rubrics with your marks (refer to the Rubric Library section in Chapter 9 for more information on rubrics).

To add a mark to a paper:

1. If you would like to associate a rubric with your mark, select a rubric using the rubric pulldown.

   \[\text{You will only be able to associate a rubric with your mark if you selected a rubric set when you created your assignment (refer to the Creating an Assignment section in Chapter 1 for more information).}\]

2. Click anywhere on the paper. A mark will appear where you click. If you selected a rubric, it will appear next to the mark.

After a mark has been added, it will appear both on the paper and in the top frame of the peer review form. You can later add or change rubrics associated with marks.

To add or change a rubric:

1. Select a rubric using the rubric pulldown.

2. Click the select icon next to a mark to associate the new rubric with the mark.

To move a mark:

1. Click the mark; it will change to a marker icon.

2. Click and drag the marker icon to a new location; when you let go of the mouse button, the mark will appear in its new location.

Q. Can you describe for us very briefly the kinds of studies engaged in over these 18 years? Describe for us briefly, if you studies you have made of the reactions of animal bodies or velocity bullet being fired into the various portions of those bodies?

A. Animals are used -- goats are the experimental animal of choice less public sympathy with a goat than there is with other types of experimental animals. And you need something fairly large human. Goats have been used for years. And in the course of those studies, you have made of the reactions of animal bodies or human bullet being fired into the various portions of those bodies?
Reading Reviews

Completed reviews can be accessed from three places:

1. Your peer review page (shows all papers available for review and all submitted reviews for each paper).
2. Your peer review inbox (shows each peer review as it is submitted for a given assignment).
3. The student portfolio page (accessed by clicking on a student’s name; shows all peer reviews submitted by a given student).

To view reviews from the peer review page:

- Click the read reviews icon next to the paper from your peer review page.

All of the reviews that have been submitted to the paper will be shown. To read a review, click the read full review button next to a review.

To view the reviews from your inbox:

- Click the inbox icon next to a peer review on your class homepage.

All of the reviews that have been submitted to the peer review will be shown. To read a review, click a paper title. To view all reviews that have been written for a paper, click the compare icon for that paper.

To view reviews from a student’s portfolio:

- Click a student’s name.

The student’s portfolio will open. To read a review, click a paper title next to the peer review.

The review will open. To view individual topic responses, click on the topic question links. To view the review’s metrics, click the view metric responses link.

<table>
<thead>
<tr>
<th>author</th>
<th>write review</th>
<th># reviews</th>
<th>read reviews</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pearson, Billy</td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Eileen</td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Pearson, Billy</td>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Shelly</td>
<td></td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

1 Click to read reviews that have been written for a paper.

2 Displays a full peer review.

3 Opens a peer review’s inbox.

4 Opens a full peer review.

5 Shows all of the reviews that have been submitted to a paper.
Creating a Writing Review

Writing reviews give your students the opportunity to submit a paper about what they have learned during the review process. While not part of the peer review process, a writing review is often a good follow-up to a peer review.

To create a writing review:

1. Click the *create a new assignment* link on your class homepage.

2. On the assignment page, select *writing review assignment* using the assignment type pulldown menu.

3. Select the paper assignment that the writing review will be associated with and enter the following additional information:
   - writing review title (optional)
   - point value (optional, applies only to Grade-Book users)
   - assignment start and due dates
   - additional assignment instructions (optional)

4. Click *submit* to add the writing review to your class homepage.

The writing review will stack beneath its assignment. Your students submit their writing reviews in the same way they submit papers.

---

Originality Reports are not generated for papers submitted to writing reviews. If you would like an Originality Report for a student submission, have your students submit their papers to a normal paper assignment or a revision assignment.
GradeMark™

With GradeMark you can edit and grade student papers online. You can add comments within the body of a paper, point out grammar and punctuation mistakes, evaluate the paper against qualitative or quantitative rubrics, assess the student's performance within the class and enter a grade for the paper that is automatically entered into GradeBook (optional).

GradeMark is currently compatible with the following browsers:

- Internet Explorer 6.0 (Windows)
- Mozilla Firefox 1.0+ (Windows, Mac OS X)
- Safari (Mac OS X)

You can access GradeMark from three places:

- your assignment inbox
- any student’s portfolio
- any paper within your account

To access GradeMark from your assignment inbox or from a student’s portfolio, click on the GradeMark icon next to the paper you would like to markup. A new window will open displaying the GradeMark interface. Using this interface, you can add marks and grades to student papers.

Grading Marks

GradeMark contains several tools and mark types that instructors can use in grading papers:

- comments
- inline comments
- QuickMarks
- rubrics
- general comments

Click to mark up a paper with GradeMark.
Comments

A comment is equivalent to the notes you would write in the margins of a paper. A comment might be: “Your thesis is unfocused. Consider refining your thesis in subsequent versions of this paper.”

Comments can be any length you would like.

To add a comment to a paper:

1. Click on the paper where you would like to add a new comment or click on an existing mark.
2. Enter text into the text field of the comment bubble.
3. If desired, choose a new mark icon for the comment from the icon pulldown menu.
4. If your comment references a specific area of the paper, you can click and drag to create a highlight over the text. Multiple highlights can be added to a mark.
5. Click the done button to save the comment.

The mark icon you selected (or the default bubble icon) for your comment will appear in the body of the paper.

You can edit a mark at any time by clicking on it. If you would like to move a mark, drag the mark icon to the new location. When necessary, you can delete a mark by opening it and clicking on the trashcan in the upper left corner of the comment bubble.

The Clipboard

If you would like reuse a comment you can add it to your clipboard. The clipboard can be used to store commonly used comments in sets. Clips added to the clipboard can be used in any class or assignment in your account.

Comments can be added to the clipboard by clicking on the add clip button at the bottom of the comment bubble or through the Clipboard Library. The Clipboard Library can be accessed through the Edit button on the Clipboard Palette or through the Tools menu.
Using the Clipboard Library

To add a clip through the Clipboard Library:

1. Click on the Tools menu and select Clipboard Library.
2. Click the clipboard set you would like to add the clip to or click Create a clipboard and name the clipboard to create a new set.
3. Click New.
4. Enter up to six characters to represent the clip on the palette in the Palette Symbol field.
5. Enter the text of the clip in the Content field.
6. Click Done to complete the clip.

Your clip will now appear with the clip list for the clipboard set you selected.

To add a set to the clipboard:

1. Click on the Tools menu and select Clipboard Library.
2. Click the name of the clipboard set you would like to add to the palette.
3. Click Set Clipboard.

Your set will now appear in the clipboard on the comment bubble. To add a clip from the clipboard to the comment, click on the symbol for the clip in the palette.

To move or copy clips between sets:

1. Click on the Tools menu and select Clipboard Library.
2. Click the name of the clipboard set you would like to move or copy clips from.
3. Select the clips you would like to move or copy.
4. Select the clipboard you would like to move or copy the clips to from the Move to... (to move) or Copy to... (to copy) pulldown menu.

Your clips will now appear in the clipboard set you chose to move or copy the clips to.
Inline Comments

Inline comments allow instructors to add marks directly to the paper.

To add an inline comment:
1. Select the type tool from the comment tool pulldown menu on the menu bar ①.
2. Click on the paper where you would like to add your comment and enter your text ②.

Inline comments can be deleted by clicking on the comment and then clicking the trashcan on the upper right corner of the comment. Inline comments can be moved by clicking and dragging the comment to a new location.

QuickMarks

QuickMarks are standard or commonly used editing marks that instructors can use when editing and grading papers. The number and type of QuickMarks added to each paper in an assignment is tracked by the assessment tool in GradeMark's Statistics.

QuickMarks are stored in sets found in the QuickMark library and are added to the paper from the QuickMark palette. GradeMark automatically provides four sets of QuickMarks consisting of commonly used editing marks and standard corrections. Instructors can use these sets, create their own sets, use sets passed down from their Turnitin account administrator or use QuickMarks from a combination of sets.

Adding a QuickMark set to the palette
1. Click on the Tools menu and select QuickMark Library ③.
2. Click the name of the set you would like to add to the palette.
3. Click the Add to Palette button in the upper right corner of the set viewing window ④.
4. Close the library by clicking the "x" in the upper right corner of the library window ⑤.

The QuickMark palette will now appear containing the set you have added. To expand or hide the set in the palette, click the expand/collapse button in the upper right corner of the set.
To add a QuickMark to the paper:

1. If the QuickMark palette is not open, select it from the Tools menu.
2. Click the QuickMark you would like to add to the paper 1.
3. Click on the paper where you would like the mark placed 2.

**QuickMarks** with yellow backgrounds on the palette are dynamic. These QuickMarks require further modification when added to the paper (some are resizeable using handles in the mark’s corners, while others allow for text to be added in a text field).

To create a QuickMark:

1. Click on the Tools menu and select QuickMark Library.
2. Click the name of the set you would like to add to the QuickMark to 3.
3. Click the New button in the upper left side of the set viewing window 4.
4. Enter the following information for your QuickMark 5:
   - a QuickMark symbol up to 6 characters in length
   - a QuickMark name
   - a QuickMark description
   - an optional content link; you might link to a site with more information on the QuickMark.
5. Click Done to save the new QuickMark 6.

To edit a QuickMark:

1. Click on the Tools menu and select QuickMark Library.
2. Click the name of the set containing the QuickMark you would like to edit 3.
3. Click pencil icon to the right of the QuickMark you would like to modify 7.
4. Edit the QuickMark
5. Click Done to save your changes
To move or copy QuickMarks between sets:

1. Click on the **Tools** menu and select **QuickMark Library**
2. Click the name of the QuickMark set you would like to move or copy QuickMarks from.
3. Select the QuickMarks you would like to move or copy
4. Select the set you would like to move or copy the QuickMarks to from the **Move to...** (to move) or **Copy to...** (to copy) pulldown menu

Your QuickMarks will now appear in the set you chose to move or copy the QuickMarks to.

**Instructors** may only add, delete, move, copy, or edit QuickMarks in sets that they own. QuickMarks sets with a lock icon to the right of the set name cannot be modified.

**Rubrics**

Rubrics can be used to evaluate student work based on defined criteria and scales.

To create a rubric:

1. Click on the **Tools** menu and select **Rubric Library**
2. Click **Create a new rubric** at the bottom of the rubric list
3. Click the **Get Started** button to begin creating a rubric
4. Enter a name for the rubric in the rubric name field
5. Click inside the criteria fields to enter your criteria (click **Add Criteria** if you would like to use more than three criteria)
6. Click below the criteria name fields to enter descriptions for your criteria
7. Click the **Next** button to move to the Scale creation screen
8. Click inside the scale fields to enter your assessment scale (click **Add Scale** if you would like to use more than three scale levels)
9. Click the **Next** button to move to the final screen
10. Click inside a descriptor field to enter an explanation of what qualifies for that scale value of that criterion (repeat for remaining descriptors)

11. If you would like the rubric to be used to score papers, select a scoring method from the Scoring-pulldown menu

12. Enter the appropriate point or percentage value for each criterion and scale value.

13. Click Finish to complete the creation of your rubric.

When creating scoring rubrics, please be aware of the following:

- If you are using criteria as percentages and would like each criterion to be worth the same percentage, select the Distribute Criteria % option to automatically distribute the percentages evenly.

- The values in the Max Points fields cannot be altered. These values reflect how many points towards the total points for the rubric will be awarded if a paper receives the highest possible scale value for the criterion, e.g. if you have a rubric with a total point value of 100, a highest scale value of 100 and a criterion worth 20% the Max Points for that criterion will be 20.

- If you are using criteria as percentages and scale as percentage, you must set the total point value for the rubric.

To modify a rubric:

1. Click on the Tools menu and select Rubric Library

2. Click the name of the rubric you would like to edit.

3. Click on the text you would like to modify and make the changes.

4. Click Done.

If you choose to apply the changes you make to a rubric that is attached to the current assignment, any scoring you have done on the rubric scorecard of any paper in the assignment will be erased. Changes will not be applied to the rubric scorecard of previous assignments.

To attach a rubric to an assignment:

1. Click on the Tools menu and select Rubric Library.
2. Click the name of the rubric you would like to attach.

3. Click Attach to Assignment ①

To use a rubric:

1. Click rubric scorecard at the bottom of the GradeMark window ②
2. Click the scale value you would like to assign the paper for each criterion ③.

General Comments

If you would like to write a general comment regarding the paper you can use the general comments tool.

To add a general comment:

1. Click the general comments link at the bottom of the GradeMark window ④.
2. Enter the comment you would like to add in the General Comments field.

Assessment

Paper and Assignment Statistics

You can use the Statistics tool under the Tools menu to view the current student's paper in comparison to the rest of the class' performance in the same assignment. The tool contains statistics for the grade given to the paper vs. the overall class grades in the assignment, the rubric scores for the paper vs. the rubric scores for all other papers submitted to the assignment, and the QuickMarks used in the paper vs. Quickmarks used in all other papers submitted to the assignment.

Statistics cannot be viewed for papers submitted by the instructor for non-enrolled students.

To view grade statistics:

1. Select Statistics from the Tools menu ⑤.
2. Click Grading on the assessment graph (a graph displaying the student's performance vs. the class average on all assignments will open) ⑥.
3. Click All assignments to open the list of assignments ⑦.
4. Click the name of an assignment to view the graph for the individual assignment.

To view rubric statistics:
1. Select Statistics from the Tools menu.
2. Click Rubrics on the assessment graph (a graph displaying the paper rubric score vs. the class rubric scores on the assignment will open).
3. Click Rubric to open the list of criteria.
4. Click the name of a criterion to view the graph for the individual criterion within the rubric.

To view QuickMark statistics:
1. Select Statistics from the Tools menu.
2. Click Quickmarks on the assessment graph (a graph displaying the paper QuickMark use vs. the class Quickmark use on the assignment will open).
3. Click the name of a QuickMark set to open the list of Quickmarks within that set and to display a graph of that set's use.
4. Click the name of a Quickmark to view the graph for the use of the individual Quickmark.

Additional Functions

The Comment List
You can view all of the marks that have been added to a paper through the comment list. The comment list can be opened by clicking comment list at the bottom of the GradeMark window. You can navigate to a mark in the paper by clicking on that mark in the comment list.

Navigating Between Marks
You can jump from mark to mark using the navigation arrows at the top of the GradeMark interface.

- Clicking the up arrow will take you to the previous mark in the paper.
- Clicking on the down arrow will take you to the next mark in the paper.

As you move from mark to mark, the comment bubble will open. You can use the navigation arrows to quickly jump between and edit marks.
Navigation Between Papers

If you are grading several papers and would like to jump to the next or previous paper without returning to your inbox, you can do so using the **previous** and **next** navigation links at the top of each paper. Each time you jump from one paper to another, the paper you are grading is automatically saved.

Entering a Grade

To grade a paper, enter a numeric grade in the grade field at the top of the paper. If you are using a scoring rubric, a grade will automatically be entered in the grade field when you complete the rubric scorecard.

E-mailing Students

You can e-mail the student of the paper you are currently grading by clicking the student's name under the paper title.

Student View

To see paper you are marking up as your students will see it, select **Student View** from the View menu. You can switch back to the instructor view by deselecting student view.

Printing

You can print papers in a printer friendly format by clicking the print icon.
5 GradeBook

With GradeBook you can track grades and attendance online. To open GradeBook, click the gradebook tab on the class bar ①.

Students enrolled in your class appear in the left column of your GradeBook. Turnitin assignments from your class are listed along the top ②.

There are a few ways to enter grades into GradeBook. You can enter grades directly into GradeBook from the GradeBook assignment and student pages. Or, you can choose to let GradeBook handle the grades you enter for papers and peer reviews outside of GradeBook. For example, you can enter grades using GradeMark, or you can enter a grade while you are viewing a paper or peer review.

Point Values

Each assignment in GradeBook has an assigned point value. When you create an assignment, you can enter a value for the assignment. From your GradeBook you can add a point value to an assignment or adjust its existing point value at any time.

To add a point value to an assignment or modify an existing assignment’s point value:

1. Click the grade button beneath an assignment to open the GradeBook assignment page ③.
2. Enter a value in the maximum points field ④.
3. Click submit to change the assignment's point value.

To return to your GradeBook, click the submit button.

Adding Entries

Assignments that have been added to Turnitin (paper assignments, peer reviews, etc.) are automatically entered into GradeBook. Any additional grade entries, such as exams or presentations, must be added manually.
To add an entry to GradeBook:

1. Click the **add entry** tab.

2. On the entry page, enter the following:
   - an entry name
   - a point value for the entry
   - additional information for the entry (optional)

3. If you would like to group the entry with an existing assignment, use the pulldown to choose an assignment. Grouping an entry makes it appear as a subset of the larger assignment.

4. Click *submit* to add the entry to GradeBook.

**GradeBook Preferences**

The preferences page lets you control the format (letter, point scale, etc.) in which your grades are displayed, and also allows you to customize the percentage values that equate to any given grade. (For example, A = 92%-100%, C+ = 78%-79%, etc.) To open your GradeBook’s preferences page, click the **prefs** tab.

From the preferences page, you can choose and customize how grades are displayed and the percentage value used to determine the grades. You can choose to display grades as a percentage, a letter grade, or using a 4.0 scale.

If you grade using a different grading system, you can create your own grading format by selecting *other* and entering the percentage breakdowns and grades you would like to use.

If you are using a customized grading scale, be sure you account for all possible percentages. If there are any gaps, you will receive an error message.

Once you have selected a format for your grades, determine the breakdown you would like to use for each grade. If you would like to use values from another one of your classes, use the pulldown menu to select the class. When you are done modifying your grading system, click *submit* to return to GradeBook.
# Entering Grades

You can enter grades from your GradeBook assignment or student page.

The GradeBook assignment page lists all student submissions to an assignment. To open an assignment page, click the grade button beneath an assignment ①.

The GradeBook student page shows a selected student’s submissions and grades. To open a student page, click a student’s name ②.

To grade a submission, enter an integer point value next to a submission ③. To view the grades before submitting them to GradeBook, click the calculate link ④.

When you have entering point values, click the submit button. The grades will be entered into your GradeBook and you will be returned to the GradeBook main page. The main page shows the point values you just entered along their corresponding grades.

## GradeBook Student Page

The top of the student grade page gives you a summary of a student's grades and attendance. If you have scaled the grades in your class, an asterisk will show up next to the student's overall grades indicating that the values are scaled values. You can toggle between viewing scaled and natural grade values using the show totals pulldown ⑤. Refer to the section Scaling and Dropping Grades in this Chapter for more information on scaling grades.

If you would like to view a student's grades in a variety of graphical formats using our graphing tools, click the graph icon ⑥. For more information on using GradeBook's graphing tools, please refer to the section Graphing Tools later in this Chapter.
Notes

If you would like, you can send a note to a student along with a grade.

To enter a note:

1. Click the note icon next to a submission.
2. On the note page, enter your note and click submit.

Students will be able to read your notes from their own student grade page.

You also have the option of entering general notes for a student from the student notes page. To open the student notes page, click the notes icon.

From the student notes page, you can add general notes by clicking the add note link. You can also perform these actions:

- toggle between viewing assignment specific and general notes using the show pulldown.
- update and delete notes.
- return to the student's grade page.

1. Click to enter a note.
2. Opens a students' notes page.
3. Click to add a general note to the student note page.
4. Choose the notes you want to view using the pulldown.
5. You can update and delete student notes.
6. Return to the student's grade page.
Scaling and Dropping Grades

With GradeBook you can scale your grades and re-calculate them instantly. You can also choose to drop each student’s lowest grade. To open the scale page, click the *scale* tab on your GradeBook main page.

The scale page shows all of your assignments and entries along with their point values. The natural value column shows the value of the assignment without scaling. For example, if your GradeBook had four assignments each with a value of 100 points, each assignment’s natural value would be 25 percent.

To increase or decrease the value of an assignment, enter a new value in the scaled value field. Make sure the values add up to 100 percent. To view the new scaled grades, click the *submit* button to return to your GradeBook.

Scaling grades does not change the current point values of your assignments. Instead, scaling creates new values for assignments relative to each other, which are reflect in the total percentage and final grades only.

The GradeBook will now display grades based on the new scaled values you entered. If you would like to view grades based on their natural value, click the *hide scaling* link. To change scaled values, return to the scale page and adjust your grades.

Dropping Grades

If you would like to automatically drop your students' lowest grades, select *yes* next to the drop lowest grade option on the scale page. When lowest grades are dropped they will not count towards your students' final grades.

When you choose to drop grades, each student's lowest grade is marked in GradeBook. You can reinstate lowest grades at any time by returning to your scaling page and turning the drop lowest grade feature off.
Graphing Tools

With Turnitin's graphing tools, you effectively track class and student performance. To access GradeBook's graphing tools, click the graphs tab ①.

On the graphs page, use the show pulldown to choose what type of graph you would like to view ②. You can choose from the following graphs:

- graphs showing class performance for all assignments
- graphs showing class performance for one assignment
- graphs showing student performance for all assignments or one assignment
- a graph comparing a student's performance to the rest of the class

Most of the graphs are available as either a line graph or a pie chart. If you choose to view a graph for student performance or a graph measuring performance for an assignment, a new pulldown labeled for will appear. You will need to select a student or an assignment depending on which type of graph you are viewing ③.

When you view a line graph, you have the option of showing grades in addition to percentages. To show grades, select grades using the show breakpoints as: menu ④. If you would like to hide the grades and only view percentages, select percentages.

When you view the bar graph for class performance for one assignment, you have the option of viewing the distribution breakdown using either percentages or points using the break down distribution using: pulldown ⑤.
Printing Graphs

All of the GradeBook graphs are printer friendly. To view a graph in print format, click the print link below the graph 1. The graph will open in a separate window. You can print the graph using your browser's print command.

Attendance

You can track student attendance using the GradeBook attendance page. To open the attendance page, click the attendance tab on your GradeBook main page 2.

The attendance form lists students enrolled in your class. The top of the form shows the current date. If you would like to mark absences and/or tardies for a different date, use the pulldowns or click on the calendar button to select a date.

To mark a student absence or late:

1. Click a checkbox in either the absence or late column 3.
2. Click submit to mark the selected students absent or late.

Absences and tardies show up on your GradeBook main page.

Exporting GradeBook

If you would like to track grades offline, you can export GradeBook as a Microsoft Excel spreadsheet. To export GradeBook, click the export tab on your GradeBook main page 4. The GradeBook will download to your computer.

GradeBook Key

Click the key tab to view a key explaining the meaning of the asterisks that appear in GradeBook 5.
Digital Portfolio

Digital Portfolio lets you create a digital portfolio assignment that allows for any type of file submission up to 5 megabytes in size. Once a file is submitted, it is stored securely on our servers and can be retrieved from any computer with an internet connection.

Originality Reports are not generated for files submitted to Digital Portfolio.

Creating a Portfolio Assignment

Before you or your students can begin submitting files to Digital Portfolio, you must create a portfolio assignment.

To create a portfolio assignment

1. Click the create a new assignment link.
2. On the assignment page, select portfolio assignment using the assignment type pulldown menu.
3. Enter the following:
   • portfolio assignment title
   • if you would like the portfolio assignment to show up in GradeBook, select yes using the pulldown next to the entry option and enter a point value (optional; shown only if GradeBook is active)
   • special assignment instructions (optional)
4. Select a start and due date for the assignment. If you would like, you can also choose specific start and due times for your assignment as well. Students can begin submitting files to the portfolio assignment once the start date arrives and will be blocked from submitting files once the due date has passed. Select yes using the pulldown next to the option to allow submissions after the due date if you would like to allow submissions after the due date has passed.
6. Click submit to finalize the portfolio assignment. It will appear on your class homepage.
Submitting Files

The steps for submitting a file are very similar to the steps for submitting a paper to a regular Turnitin assignment. There are two differences between submitting a paper to a portfolio assignment and a regular assignment:

- Cut-and-paste is not a submission option when submitting a file to a portfolio assignment.
- You can only submit a file for a student enrolled in your class; anonymous submissions are not allowed.

For step-by-step instructions on submitting a file, refer to the section Submitting Papers in Chapter 1.

Portfolio Inbox

The inbox for portfolio assignments is very similar to the assignment inbox described in Chapter 1. There are two differences between the portfolio inbox and the assignment inbox:

- Since there are no Originality Reports for portfolio submissions, Originality Report related functions have been removed.
- All GradeMark related functions have been removed.

For step-by-step instructions on managing your portfolio inbox, refer to the section Assignment Inbox in Chapter 1.
Class Calendar

The class calendar keeps track of your Turnitin assignments’ important dates and lets you add class notes, announcements, and holidays. If you have a syllabus for your class, you can upload it to your calendar. Students access information posted to the calendar from their own student calendar.

Opening the Calendar

To open a class calendar, click the calendar button on the class bar.

When you open a calendar, it will display the current month and year. You can view a different month by clicking on the month tabs along the top of the calendar. To change the year, use the year pulldown menu.

Assignment Dates

Assignments and peer reviews you create are automatically added to your calendar. A link appears for each assignment’s date displaying the assignment or peer review’s title. To view a summary of an assignment or review, click the assignment or review title.

Calendar Entries

Class Notes

Class notes uploaded to your calendar are accessible to students enrolled in your class. You can add a single set of notes to a calendar date or you can upload notes for multiple dates using the bulk upload feature.

To add a single set of class notes:

1. Click on the date for the notes (for example, if the notes are for the 4th of the month, click the 4 on your calendar).
2. From the calendar entry page, click the Browse button to locate a set of notes to upload.
We accept submissions in Microsoft Word, WordPerfect, RTF, PDF, PostScript, plain text, and HTML format.

3. Click submit to upload the notes to your calendar.

To add multiple sets of class notes using bulk upload:

1. Click on any date on your calendar to open the calendar entry page.
2. From the calendar entry page, click the bulk upload link
3. Click the Browse button and locate a set of notes.
4. Enter a title for the notes.
5. Select a date for the notes.
6. Click attach to add the notes to your batch
7. Repeat steps 3 through 5 for each set of notes you would like to add to your calendar.
8. When you are done adding papers, click the submit button to upload the batch of notes to your calendar.

A notes icon will appear on your calendar for each set of uploaded notes. To display the notes, click the notes icon.

Announcements

You can add class announcements to your calendar. Students will be able to access these announcements from their calendar pages.

To add an announcement to the calendar:

1. Click on the date for the announcement (for example, if the announcement is for the 4th of the month, click the 4 on your calendar).
2. On the calendar entry page, enter a title and additional information for the announcement.
3. Click submit to add the announcement to your calendar.

An announcement icon will appear on your calendar along with a linked announcement title. To view the full announcement, click the link.
To delete an existing announcement:

1. Click on the date of the announcement.
2. The entry screen will display all announcements that have been added for the displayed date. To delete an announcement, click the announcement’s delete icon ①.

**Holidays**

From the entry page, you can add holidays to your calendar. If class does not meet on the specified holiday, you can designate the holiday as a day off.

To add a holiday to the calendar:

1. Click on the date for the holiday (for example, if the holiday is on the 4th of the month, click the 4 on your calendar).
2. On the calendar entry page, enter a name for the holiday.
3. If class does not meet on that day, click the checkbox to mark the day as a day off.
4. Click submit to add the holiday to your calendar.

The name for the holiday will appear on your calendar ②. If students have the day off, the day will be highlighted.

**Uploading a Syllabus**

If you have a class syllabus, you can upload it to your calendar. Students can view and download the syllabus from their calendars.

To upload a syllabus:

1. Click the syllabus link from your calendar ③.
2. From the syllabus page, click the Browse button and locate the file you would like to upload.

We currently accept syllabus submissions in Microsoft Word format only.

3. Click submit to add the syllabus.

The syllabus will be posted to the syllabus page. If you post another syllabus, your current syllabus will be replaced.
Calendar List

You can also view your calendar in list mode. The list mode displays all assignments and entries in a list. Dates that do not have assignments or entries are excluded from the list.

To switch to the calendar list, click the list link on your calendar. The calendar list mode works similarly to the calendar mode. You can view any item by clicking on it. If you would like to update an item, click the item’s update icon.

To switch back to the calendar view, click the calendar mode link.
Discussion Boards

Discussion boards let teachers set up an online forum where students can discuss topics relevant to their class. Instructors can post topics for student discussion or they can choose to let their students contribute topics to the forum.

To access your class discussion board, click the discussion tab on the class navigation bar 1.

Posting a Discussion Topic

When you first visit your class discussion board, it will not contain any topics for discussion. Your students will not be able to start using discussion boards until you post a topic.

To post a topic to your discussion board:

1. Click the post a new topic link 2.

2. Enter the following topic information:
   - topic title
   - enter a topic description (optional)

3. Choose a start and end date for your topic. Students will not be able to post to a discussion before the start date or after the end date.

4. Choose whether you would like to moderate the topic. If you choose to moderate the topic, you can select yourself as the moderator or you can choose a student to moderate the discussion.

   When a discussion is moderated, students cannot read posts until they have been approved by the moderator. Refer to the section Moderation in this chapter for more information.

5. Choose whether you would like replies to be anonymous. If you choose yes all posts will be anonymous for everyone in the class except yourself.

6. Click submit to add the new topic to your discussion board.

Once a topic has been added, your students can login, view your topic, and begin discussing the topic online.
Discussion Page Overview

The discussion page lists all discussion topics for your class and gives you a quick overview of all the discussions in your class.

The status column shows whether a topic is active or inactive. Your students will only be able to reply to active topics.

The replies column shows the total number of replies to a topic.

The new column shows how many replies have been made since you last viewed a topic.

If you have chosen a moderator for a topic, the pending column shows how many replies need to be moderated (refer to the Moderation section in this chapter for more information on how moderating works).

The last reply column shows when the last reply was posted to a topic.

The moderator column displays the topic's moderator. If no moderator has been chosen, (none) appears in this column.

If you would like to change a discussion topic's title or dates, add a moderator to a topic, or make replies to a discussion topic anonymous, click the update button next to the topic (refer to the section Posting a Discussion Topic above for more information on these options). To delete a discussion topic, click the delete button next to the topic.

The pulldown on the discussion page lets you choose to view all topics, active topics, pending topics, or inactive topics. The default view is all topics.

Posting a Reply

To view a discussion with its responses, click the discussion topic's title. The page that opens displays the discussion topic at the top of the page and any responses beneath the topic.
To post a reply to a topic:

1. Click the *reply to topic* button next to the discussion topic.

2. Enter your response in the reply box. By default, the post you are replying to is shown. If you would like to see the entire thread, use the pulldown at the top of the form and select *entire thread*.

3. Click *submit* to add your reply to the discussion.

In addition to responding to the topic, you can also respond to a reply.

To post a response to a reply:

1. Click the *reply* link next to the response you would like to reply to.

2. Enter your response in the reply box. By default, the post you are replying to is shown. If you would like to see the entire thread, use the pulldown at the top of the form and select *entire thread*.

3. Click *submit* to add your reply to the discussion.

After posting a response, you can edit it by clicking the *edit* link. To delete your response, click the *delete* link. If someone replies to your response, you will no longer be able to edit or delete your post.

**Discussion Views**

There are two main discussion views you can choose from—a flat view and a threaded view. Both views use the following structure:

1. **topic**
   1.1 *first response to topic 1*
      1.1.1 *response to 1.1*
   1.2 *second response to topic 1*
      1.2.1 *first response to 1.2*
      1.2.2 *second response to 1.2*

**Flat View**

The flat view is the default view and shows responses flat in thread order like the structural diagram above.
With the flat view, you have the option of viewing responses with or without threads. By default, the thread is shown. For example, if someone posts:

_I agree with this topic_

and you reply to the above post with:

_Why do you agree with the topic?_

Your post will look like this:

_I agree with this topic_

_Why do you agree with this topic?_

This view, _flat view with nested threads_, is the default view 1. If you would like to only view responses and not see referenced thread 2, you can choose _flat view with no thread_ using the "show replies as" pulldown on the discussion page 3.

**Threaded View**

You also have the option of using a threaded view to view a discussion. To use the threaded view, choose _threaded view_ using the "show replies as:" pulldown on the discussion page 4.

When you choose to view a discussion using the threaded view, only the top response of each thread is shown. For example, if a discussion has this structure:

1. topic
   1.1 first response to topic 1
      1.1.1 response to 1.1
   1.2 second response to topic 1
      1.2.1 first response to 1.2
      1.2.2 second response to 1.2

only responses 1.1 and 1.2 will be shown in the threaded view. If you would like to view the replies to 1.2, you can click on the replies link to display the responses to this thread. If there are responses to the responses shown, you can drill down further by clicking on more reply links.

If you would like to go up a level, you can click on a thread title. You will be taken back up to the level you have clicked to.
Viewing Replies by User

You can view replies by user using the "show replies from" pulldown. You and your students show up in this pulldown. To view only responses from a given student, select the student's name using the pulldown 1. You can view your responses by selecting your own name.

Sorting Replies

You can sort replies by status, author, reply number, date posted, and number of replies by clicking a column header. For example, if you would like to sort replies alphabetically by author, click the author header 2. Clicking a header once will sort replies in ascending order. Clicking a column again will reverse the sort order.

Moderation

If you would like student replies to be reviewed and approved before they become part of the discussion, you can assign yourself or a student as a moderator. A moderator is selected when you add a discussion topic. For information on assigning a moderator, refer to the section Posting a Discussion Topic earlier in this chapter.

If a moderator is assigned for a discussion, all student replies are pending replies and show up for the moderator only. A moderator can get a quick overview of the number of pending replies in each discussion topic from his or her discussion board main page.

For a pending reply to become part of the discussion, the moderator must approve a reply. This can be done from the discussion page.

To approve a reply:

1. Click the approve link next to a pending reply 3. The reply will be displayed.
2. Edit the reply if you would like.
3. Using the "approve?" pulldown at the top of the form, choose yes to approve the reply and add it to the discussion ①. If you do not would like to approve the reply, select no.

4. Click submit. If you chose to approve the reply, it is added to the discussion. If you chose not to approve the reply, you will be asked if you would like to delete the reply or save it for later.

Once a reply has been approved, it will be assigned a number and added to the discussion.

Letting Students Post Topics

Discussion topics posted by students must be approved by the class instructor before they are added to the class discussion board. Pending topics show up at the top of the instructor's discussion homepage.

To approve a student posted discussion topic:

1. Click the title of the pending discussion topic ②.

2. Complete the discussion topic form. If you would like you can edit the student's topic title or description. For information on completing this form, refer to the section Posting a Discussion Topic in this chapter.

If you would like to prevent students from posting topics, you can do so from your class preferences. For information on modifying your class preferences, please refer to Chapter 12.
9 Libraries

Your libraries store information from assignments, rubrics, and peer reviews that you have created. You can use your libraries to import assignments and peer reviews to classes, manage your rubrics, and add topic and metric questions to new peer reviews.

You can open your library page from anywhere within a class. To open your library page, click the libraries tab on the class bar 1.

Assignment Library

Your assignment library helps you manage all of the assignments you have created. When you create an assignment for a class, the assignment is added to that class’ assignment set. When you open your library page, your assignment library defaults to your current class’ assignment set. To switch to a different assignment set, use the pulldown to select a class.

Importing Assignments

From your assignment library, you can import assignments to your class.

To import an assignment to your current class:

1. Click the checkbox next to the assignment(s) you would like to import 2.
2. Click the import button above the checkbox column 3.
3. Choose whether you would like to use the assignment dates from the library or enter your own dates. To use library dates, click the preserve dates link. To enter your own dates, enter a start and due date and click submit.

If you are importing more than one assignment, the dates you select will be applied to all of the assignments. You can later edit the dates for individual assignments by clicking on an assignment’s update button.
Rubrics Library

To open your rubrics library, click the rubrics tab from your library page ①.

Your rubrics library lets you create new rubrics and organize existing rubrics into sets. These rubric sets can then be used with Peer Review. With rubrics, you can identify common problems in student papers quickly and easily. For example, instead of adding comments to a student paper each time a student uses passive voice, you can create a rubric that you can place throughout a paper each time that student uses the passive voice.

Before you can create rubrics, you must first create a rubrics set.

To create a rubrics set:

1. Click the create new rubrics set link ②.
2. Enter a name for the rubric set and an optional rubric set description.
3. Click submit to add the rubric set to your library.

Once you have created a rubric set you can create new rubrics and add them to your set.

To create a new rubric:

1. Click the create new rubric link ③.
2. Enter the following information:
   - a rubric name
   - a rubric symbol up to six characters in length
   - an optional content link
   - an optional remediation quiz link
   - an optional rubric description
3. Click submit to add the rubric to your current rubric sets.

Once you have created rubrics and added them to a set, you can export them to other rubric sets.

To export rubrics to another rubric set:

1. Select the rubrics you would like to export by clicking on the rubric’s checkbox ①.
2. Click the **export** button above the selected check-boxes.

3. Use the rubric set pulldown to select a target set for the selected rubrics. Click **submit** to add the rubrics to the selected set.

With rubric sets, you can use a single set of rubrics for all of your classes and assignments or create separate sets of rubrics for specific assignment and class types.

**Modifying and Deleting Rubric Sets**

To modify or delete a rubric set, select a rubric set and click on its name. From the page that opens, you can make changes to your rubric sets name or description. You can also delete a rubric set by clicking the **delete set** link.

**Peer Review Library**

Your peer review library keeps track of all the peer reviews you have previously created. To view your peer review library, click the **peer review** tab on your library page.

All reviews you have created for your current class will be displayed. Using the class pulldown, you can view reviews from your other classes.

When you are creating a peer review, you can choose to select a review from your library in step one of the review assignment creation process. Selecting this option will open your peer review library. To select a review from your library, click the select icon.

You will only be able to select a peer review from your library during step one of the peer review creation process.
Topic Question Library

To open your topic question library, click the topic questions tab on your library page.

The topic question library keeps track of all the topic questions you have created for your peer reviews. The library also contains Turnitin topic questions that you can use in your reviews.

There are two available sets of topic questions. Selecting my questions lists the topic questions you have previously created. Selecting library questions shows the Turnitin library questions. If you would like to see both your questions and the Turnitin library questions, select both.

After you have selected a set of questions, you can view them by category. Selecting the thesis category, for example, will list all topic questions that pertain to the thesis of a paper.

If you choose to select a topic question from your library during step two of the peer review creation process (refer to Chapter 3), you can select topic questions to add to your review by clicking on the checkbox next to the questions you would like to add. Once you have selected topic questions, click the import button to add them to your review.

Metric Library

To open your metric library, click the metrics tab from your library page.

The metric library keeps track of all the metric questions you have created for your peer reviews. The library also contains Turnitin metric questions that you can use in your reviews.

There are two available sets of metric questions. Selecting my metrics lists the metric questions you have previously created. Selecting library metrics shows the Turnitin metric questions. If you would like to see both your metric questions and the Turnitin metric questions, select both.

Once you have selected a metric set, you can view the metric questions by category. Selecting the
conclusion category, for example, will list all metric questions that pertain to the conclusion of a paper.

If you choose to select a metric question from your library during step three of the peer review creation process (refer to Chapter 3), you can select metric questions to add to your review by clicking the checkbox next to the metric question you would like to add. Once you have selected metric questions, click the import button to add them to your review.
Class Sections

If sections of your class are taught by other instructors or teaching assistants, you can create a class with sections. When you create a class with sections, a top-level master class is created. From the master class, an instructor or administrator can choose to set up all sections for their TAs or let their TAs manage their own classes either on their own or by using guidelines created by the master class instructor.

Creating a Master Class

To create a class with sections, click the add a class link. On the add a class page, select master class using the class type pulldown. Enter a name for your class and a TA join password. Your TAs can use this password to join your class and set up their sections. Click submit to add the master class to your homepage.

If you have an existing class and would like to change it to a class with sections, you can convert the class to a master class.

To convert a regular class into a master class

1. Click the update button next to the class you would like to convert.
2. Click the convert to master class button to change your standard class to a master class.

If there are any students or papers in your class, they will be moved to a newly created section beneath your master class.

Adding Sections

There are two ways to add sections to your class. You can manually set up all of your sections and enter TA information for each section, or you can distribute your class ID and TA join password and let your TAs join you class and set up their sections themselves.

We encourage you to distribute your class information and let your TAs set up their sections themselves as it will save you time.
To let your TAs join your class and set up sections, distribute your class ID and TA join password to your TAs. Once they have the class ID and TA join password, they will log in as instructors and join your class by clicking the **join class (TA)** button. Once joined, the TA will set up his or her class section. This section will appear beneath your class on your homepage.

**To create a class section and add TAs yourself:**

1. Click the **add section** button next to your master class.
2. On the add section screen, enter the following TA information:
   - TA’s last name
   - TA’s first name
   - TA’s e-mail address
   
   Click *submit* to proceed to the next step.

4. On the next page, enter the following section information:
   - section enrollment password (students will use this password to enroll in the section)
   - section name

5. Click *submit* to add the section to your class.

Each section will appear on your homepage beneath your master class. When a section is added, an e-mail with the section information will be sent to the TA. If the TA does not have a user profile with Turnitin, we will generate a profile for the TA and include this information in the e-mail.

**Administering a Master Class**

As a master class instructor, you have several options for managing your class and its sections. Here are a few ways you might manage your class:

- create template assignments that become part of your class assignment library; your TAs can then create their own assignments or choose to select your assignments from the class assignment library (refer to the section Assignment Library in Chapter 9 for more information on using the assignment library)
• create complete assignments and add them to some or all of your sections
• create partial assignments (for example, assignments that contain basic assignment information but do not contain dates) and add them to some or all of your sections

As with other Turnitin classes, assignments are added to the master class homepage. To view your master class homepage, click the title of your master class 1.

Creating Assignments

The process for creating an assignment within a master class closely resembles the class creation process for a normal class. For an overview on creating assignments, please refer to the section Creating an Assignment in Chapter 1.

Adding Assignments to Sections

When you create a master class assignment, you have the option to add it to some or all of your sections.

To add an assignment to one or more sections:
1. On the assignment creation page, make sure you have selected yes next to the option do you would like to push this assignment to your sections? (note that this option is set to yes by default) 2.
2. Click submit to advance to the assignment push page.

The assignment push page lists all of your sections and lets you choose which sections will receive your assignment. By default, all sections are marked to receive your assignment. If you do not would like to push the assignment to a specific section, click the checkbox in the push? column to uncheck the box. Only sections with a check in the push? column will receive your assignment when you click submit.

Adding Assignments Without Dates

You have the option to push assignments to sections without dates. If an assignment is pushed without dates, the assignment will be in an inactive state and students cannot submit papers to the assignment until the TA chooses dates for the assignment.
To push an assignment to a section without dates, click on the checkbox next to the option *push with dates?* to unmark the checkbox. When you click submit, the sections you have selected for the assignment will receive the assignment without dates.

### Master Class Homepage

The master class homepage shows all of the assignments you have created for your class. The *push to sections* column shows whether an assignment has been pushed to sections and whether it has been pushed to all sections or selected sections.

- *not pushed* indicates that an assignment has not been pushed to any sections
- *partial* indicates that an assignment has been pushed to at least one section but not all sections
- *full* indicates that an assignment has been pushed to all sections

You can revisit the assignment push page at any time by clicking the *push to sections* button next to an assignment.

If you have previously added an assignment to a section, you can push the assignment to the section again with any changes you have made. You can do so if the assignment has not been altered by the TA or if a paper has not yet been submitted to the assignment. Once any part of an assignment is changed or a paper is submitted to an assignment, it is locked. The messages on the push page next to each assignment will tell you if an assignment is unmodified or if it is locked.

*If you need to alter a locked assignment, you must do so from within the assignment’s section.*

### Student Enrollment

Students cannot enroll directly in a master class but can enroll in one or more class sections. There are several ways students can enroll in a section. The recommended and fastest way to get students started is to provide them with their section's class ID and enrollment password and let them enroll themselves.

You can also choose to add students from within a
section. For step-by-step instructions on enrolling students in a class, refer to the section *Getting Your Students Started* in Chapter 1.

If you prefer, you can add students from your master class list.

**To add students from the master class:**

1. From your master class homepage, click the *students* tab on the class navigation bar ①.
2. Click the *add student* link on the students page ②.
3. Select the section you would like to enroll a student in using the section pulldown menu ③.
4. Enter the following information:
   • student last name and first name
   • student e-mail address
5. Click *submit* to add the student to the section.

The student will appear on your master student list ④.

**GradeBook**

If GradeBook is active for your account, you can click the *GradeBook* tab on the class navigation bar ⑥ and get a quick overview of the grades in your class ⑤. If you would like to view detailed grade information for a student or section, click on the student or section's name to jump to that section's GradeBook.

**Calendar**

To view your master class calendar, click the *calendar* tab on the class navigation bar ⑥. The master class calendar functions similarly to the class calendar. For information on using the calendar, refer to Chapter 7.

Any announcements, notes, or holidays that you add to your master calendar will show up on all of your section calendars as well.
Preferences

Click the preferences tab on your class navigation bar to view your master class preferences. From your master class you can determine which features are available to your sections. To enable a feature, make sure the checkbox next to feature is marked.

From your master preferences you can also choose to lock assignment information and assignment dates for the assignments you push to sections. To lock assignment dates, click the checkbox next to the option lock assignments dates? To lock all other assignment information, click the checkbox next to the option lock assignment info?
Quick Submit

Quick submit lets instructors submit papers for plagiarism detection without creating a class or assignment. It is ideal for instructors who would like to use Turnitin to check papers for plagiarism and would like to submit papers themselves. If you would like to have your students submit papers or if you plan to use Peer Review, GradeMark, or GradeBook, you should not use quick submit.

Accessing Quick Submit

To enable quick submit, click on the user info button on the system bar. From the user preferences page, select yes next to the quick submit option to activate quick submit. Once quick submit is active, a quick submit tab will appear on your homepage. Click the quick submit tab to access quick submit.

Submitting Papers

To submit a paper, click the submit button at the top of the quick submit inbox.

You will first need to choose the sources that you would like the submitted paper or papers checked against. The available sources are the internet, our database of submitted student papers, and a database of periodicals, journals, & publications. To include a source in the search, click the checkbox next to the source.

The process for submitting a paper to quick submit is identical to the submission process outlined in Chapter 1 with one exception: when you use quick submit, you cannot submit papers for students enrolled in your class. For step-by-step instructions on submitting a paper, refer to the section Submitting a Paper in Chapter 1.

Papers you submit will show up in your quick submit inbox. Click the Originality Report icon next to a paper to view its Originality Report.

The quick submit inbox works just like an assignment inbox. For information on organizing and using your quick submit inbox, please refer to the section Assignment Inbox in Chapter 1.
Preferences & Notifications

There are two types of preferences – user preferences and class preferences. User preferences are part of your user profile, while class preferences are part of each class.

User Preferences

To view your user preferences, open your user profile by clicking the user info button on the system bar.

The user preferences are:

- **default user type** – select from student, instructor, or administrator; your default user type will be used when you log in.
- **default submission type** – select a default submission type: file upload or cut and paste; when you submit a paper, the submission screen will default to the selected submission type.
- **activate quick submit** – select yes to turn quick submit on; refer to Chapter 11 for information on quick submit.
- **items per page** – select the number of items you would like displayed per page.
- **file download format** – choose a default format for your downloads (either original format or PDF); if you would like to choose each time you download a paper, select let me choose each time.
- **show page info** – choose yes to display page information at the top of each page.
- **send me e-mail updates** – choose yes to receive e-mail updates from Turnitin.
- **use homepage link** – choose yes to create a homepage link; to set up a link, enter a link name and URL below.

If you make any changes to your user preferences, be sure to click submit to save the changes.
Class Preferences

To open preferences for a class, click preferences on the class bar ①.

Each class has the following preferences:

• **General Preferences** – choose whether you would like to allow students to view their own Originality Reports or submit discussion topics to your class. If you would like to prevent students from e-mailing you, you can hide the link to your e-mail address. If a feature is highlighted in red, your account administrator has not activated the feature for your account.

• **Products** – select the products that you would like to activate. If a product is grayed out, it has not been purchased for your account. If a product is highlighted in red, your account administrator has not activated the product for your account.

• **Class Link** – if you would like to set up a link available to you (from your class homepage) and your students (from their class portfolio), enter a link name and link URL.

If you make changes to your class preferences, click submit to commit the changes.

Messages and Announcements

You can view important Turnitin messages and announcements by clicking on the messages button on the system bar ②. An exclamation point next to the messages button indicates that you have new, unread messages or announcements.

⚠️ Urgent notifications including messages announcing scheduled downtime will appear both on your messages page and on your homepage.
13 Statistics

Each class and section has its own statistics page. From the stats page, you can view detailed usage statistics for your class.

To view class statistics, click the stats icon next to a class ①. The statistics page for the class will open.

Statistics Overview

The first column of the stats page lists your class’ enrollment password. The remaining columns list the statistical categories tracked for your class.

The default view shows you cumulative account statistics. If you would like to view statistics for a given period of time, select stats for a specific range using the show pulldown ②. You can then choose the date range you would like to view and click submit date range to view stats for the selected range ③.

The default statistics view does not include deleted objects. For example, if you have dropped a student from your class, the stats will not include the dropped student's submissions. If you would like to view all statistics for your class including deleted objects, select show dropped and deleted using the pulldown next to your class ④.

You can download your class statistics in MS Excel format by clicking on the export to Excel tab ⑤.